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Introduction 
 
PhaseCalc for Steam (PhaseCalc) is an implementation of the internationally recognized 
fundamental equation for the fluid properties and phase behavior of water. The International 
Association for the Properties of Water and Steam (IAPWS) web site at http://www.iapws.org 
contains details of the 1995 Release of the Scientific Formulation1 (IAPWS-95) on which 
PhaseCalc is based. This model was chosen over the 1997 Industrial Formulation2 (IF97) 
because of its thermodynamic consistency over the entire range of pressure and temperature, and 
because of its superior accuracy. More information about the IAPWS-95 implementation 
developed by Tomcej Engineering Inc. (Tomcej) is available on the Tomcej web site at 
http://www.tomcej.com. 
 
PhaseCalc can be used to predict the properties of water and steam over a wide range of 
pressures and temperatures of industrial interest. It can be used to analyze the performance of 
process equipment such as compressors, valves or pipeline systems, where water or steam is 
involved. PhaseCalc also includes an implementation of the IAPWS formulation for dynamic 
viscosity3 and thermal conductivity4 to assist in these process calculations. 
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Program Capabilities 
 
PhaseCalc runs essentially like a spreadsheet. By specifying any two independent properties 
and/or a condition from a given set of options, the program solves for the remaining properties. 
At present, the program will calculate the following properties: 
 
 
Table 1.  Primary Properties Calculated by PhaseCalc 
Property Symbol 
Pressure P 
Temperature T 
Density ρ 
Volume v 
Internal Energy U 
Enthalpy H 
Entropy S 
Isochoric Heat Capacity Cv 
Isobaric Heat Capacity Cp 
Sonic Velocity w 
Joule Thomson Coefficient μJT 
Dynamic Viscosity μ 
Thermal Conductivity k 
 
 
Other secondary property values are also included in the program output. These include: 
 
 
Table 2.  Secondary Properties Calculated by PhaseCalc 
Property Symbol 
Heat Capacity Ratio Cp/Cv 
Fugacity f 
Compressibility Factor Z=Pv/RT 
Mass or Mole % Vapor (Quality) x 
Volume % Vapor y 
 
 



PhaseCalc for Steam  Page 5 of 17 

Tomcej Engineering Inc.  Revision 1.0.1 

At present, the following set of specifications may be used to initiate a flash calculation. These 
specifications apply to any region: the subcooled liquid region, the superheated vapor region, or 
the saturated vapor-liquid curve. 
 
 
Table 3.  Available Calculations 
Specification PhaseCalc Nomenclature 
T and x on the Saturation Curve Saturation P at T 
P and x on the Saturation Curve Saturation T at P 
P and T Flash at P and T 
P and H Flash at P and H 
P and S Flash at P and S 
P and ρ Flash at P and Density 
T and H Flash at T and H 
T and S Flash at T and S 
T and ρ Flash at T and Density 
Critical Point Critical Point 
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Figure 1 shows the main program screen that is displayed when the first specification option 
(Saturation P at T) is selected using a temperature of 300 K and 50 mass % vapor on the 
saturation curve. 
 
Figure 1.  Main Program Screen 
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Program Input 

Flash Conditions 
Specifications for the conditions are entered in the Flash Conditions dialog shown in Figure 2. 
 
Figure 2. Flash Conditions Dialog Box 

 
 
The Flash Conditions dialog is presented when one of the calculation buttons on the main screen 
is pressed, or a menu item on the Calculation menu is selected. Depending on which calculation 
option is selected, the program will request only the required information. The input values are 
validated prior to performing the calculation to ensure they fall within the acceptable range. A 
notification message is displayed if the entered values are invalid. An example of this is shown 
in Figure 3. 
 
Figure 3.  Validation of  Input Data 
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In this example, an invalid temperature has been entered in a saturated steam calculation. 
If the entered values pass the data validation process, the program proceeds with the selected 
calculation. 
 
 

Units 
PhaseCalc uses SI units for internal calculations as this is the basis of the IAPWS-95 
formulation. Input and output may be displayed in other unit systems for convenience. At 
present, the following units are available for use: 
 
 
Table 4.  Available Unit Systems 
Property Units 
Pressure, Fugacity kPa, psi, atm, MPa, bar, mm Hg 
Temperature K, °R, °C, °F 
Density kg/m3, g/cm3, lb/ft3, kmol/m3, mol/cm3, lbmol/ft3 
Volume m3/kg, cm3/g, ft3/lb, m3/kmol, cm3/mol, ft3/lbmol 
Internal Energy, Enthalpy kJ/kg, J/g, BTU/lb, kJ/kmol, J/mol, BTU/lbmol 
Entropy, Heat Capacity kJ/kg·K, J/g·K, BTU/lb·°R, kJ/kmol·K, J/mol·K, BTU/lbmol·°R 
Sonic Velocity m/s, ft/s 
Joule Thomson Coefficient K/kPa, K/MPa, °F/psi, K/bar 
Dynamic Viscosity Pa·s, mPa·s, μPa·s, cP, lb/ft·h 
Thermal Conductivity W/m·K, mW/m·K, BTU/s·ft·°R, BTU/h·ft·°R 
 
 
The preferred units may be selected in two ways. The Tools menu contains an Options menu 
item that presents the Options dialog box shown in Figure 4. 
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Figure 4.  Selection of Default Units 

 
 
 
By selecting the Units tab in the dialog box, the preferred units system may be entered by 
selecting values from the appropriate combo boxes. For example, Figure 4 shows the selection of 
BTU/lb as the preferred unit system for enthalpy. When the Options dialog is closed, the selected 
units become the new default system. These units will be displayed when requesting program 
input, when displaying or printing results, and the next time PhaseCalc is started. 
 
As an alternative, the units for a particular property may be changed on the main screen in the 
Units column. The Units column includes a number of combo boxes that contain the available 
units for that particular property. By selecting a different set of units, the displayed property 
values for liquid, vapor and overall feed will be converted to the new units system. As with the 
options dialog box, units selected on the main screen may be saved as the new default system. 
When PhaseCalc is closed, the program will request confirmation to save the new units as the 
default system. 
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Program Output 

Main Screen 
Calculation results are displayed in the grid on the main screen. An example of the main screen 
display is shown in Figure 1. 
 

Printed Reports 
Results may also be printed or previewed by selecting the Print or Print Preview items on the 
File menu. An example of a printed report is given in Figure 5. 
 
 
Figure 5. Example Printed Report 

 
 
 
The main screen includes a text box labeled “Note:”. Any project reference or title that is entered 
in this box will be included in the printed report. 
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Display Precision 
For purposes of reproducing the results in the IAPWS guidelines, the number of digits displayed 
on the main screen and in the printed report may be adjusted on the Digits tab of the Options 
dialog box. The Options dialog is displayed by selecting the Options item on the Tools menu. 
The default display precision is six digits or less. 
 

Fluid Properties on the Saturation Curve 
For convenience, when calculations are performed on the saturated vapor-liquid curve, the 
numerical difference between the saturated vapor and saturated liquid values of either internal 
energy, enthalpy or entropy may be displayed by right-clicking the appropriate row on the main 
screen. Figure 6 shows the display when the entropy row is right-clicked. 
 
Figure 6.  Special Output Displayed on Right Click 

 
 



PhaseCalc for Steam  Page 12 of 17 

Tomcej Engineering Inc.  Revision 1.0.1 

Technical Support 
Owners of a registered copy of PhaseCalc for Steam have access to unlimited technical support. 
Please send support requests by e-mail to support@tomcej.com. Include a description of the 
problem and your contact information. Tomcej will make every effort to respond to your request 
in a timely manner. The “Technical Support Issue” menu item on the Help menu may be used to 
initiate a technical support request. 
 
Although e-mail is the preferred method of technical support, requests may also be sent by 
telefax to our head office at 1.780.483.0248. 
 
A current list of known technical issues and the status of their resolution is posted on the Tomcej 
Engineering web site at http://www.tomcej.com/support/phasecalc/steam/knownissues.htm. 
Please check this list to determine whether your problem is a known issue, prior to submitting a 
support request. 
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Appendices 

Appendix A: Examples 
It is assumed in these examples that the default units are kPa, K and kJ/kg for P, T and H 
respectively, and that the default precision is 9 digits. 

1. Saturated Mixture at 450 K with Quality of 75% 
• Click “Saturation P at T” or select the “Saturation p at T” item on the Calculation menu 
• Enter “450” in the temperature box and “75” in the mass 5 vapor box 
• Click OK or press Enter on the keyboard 
• The following results are displayed on the main screen 

 
Figure 7.  Screen Display for Example A1 
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2. Superheated Steam at 30 MPa with Enthalpy of 4000 kJ/kg 
• Click “Flash at P and H” or select the “Flash at P and H” item on the Calculation menu 
• Enter “30000” in the pressure box and “4000” in the enthalpy box 
• Click OK or press Enter on the keyboard 
• The following results are displayed on the main screen 

 
Figure 8. Screen Display for Example A2 
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3. IAPWS-95 Validation 
The following properties have been extracted from the IAPWS-95 guideline and may be used to 
confirm that the PhaseCalc program reproduces the published values 
 
Table A-3.1 Thermodynamic Properties in the Single-Phase Region 
T/K ρ/(kg/m3) P/kPa Cv/(kJ/kg·K) w/(m/s) S(kJ/kg·K) 
300 996.5560 99.242 4.13018111 1501.51914 0.393062642 
 1005.308 20002.2514 4.06798347 1534.92501 0.387405401 
 1188.202 700004.704 3.46135580 2443.57992 0.132609616 
500 0.4350000 99.9679423 1.50817541 548.314253 7.94488271 
 4.532000 999.938125 1.66991025 535.739001 6.82502725 
 838.0250 10000.3858 3.22106219 1271.28441 2.56690918 
 1084.564 700000.405 3.07437693 2412.00877 2.03237509 
647 358.0000 22038.4756 6.18315728 252.145078 4.32092307 
900 0.2410000 100.062559 1.75890657 724.027147 9.16653194 
 52.61500 20000.0690 1.93510526 698.445674 6.59070225 
 870.7690 700000.006 2.66422350 2019.33608 4.17223802 
 
Table A-3.2 Thermodynamic properties in the Two-Phase Region 
T/K P/kPa ρL/(kg/m3) ρV/(kg/m3) HL/(kJ/kg) HV/(kJ/kg) SL/(kJ/kg·K) SV/(kJ/kg·K) 
275 0.698451167 999.887406 0.00550664919 7.75972200 2504.28995 0.0283094669 9.10660120 
450 932.203564 890.341250 4.81200360 749.161585 2774.41078 2.10865845 6.60921221 
625 16908.2693 567.090385 118.290280 1686.26976 2550.71625 3.80194683 5.18506121 
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Appendix B: Software Installation and Setup 
PhaseCalc is based on the .NET Framework 2.0. .NET 2.0 must be installed on the target 
computer system prior to installing PhaseCalc. The program is distributed using a Windows 
Logo compliant InstallShield setup package. This setup package copies all the necessary files to 
run the program. 
 
PhaseCalc must be activated before it can be used to perform calculations. Tomcej allows the 
program to be installed and activated on up to two machines. Additional installations require 
special licensing arrangements. Please contact Tomcej Engineering if this is the case. Activation 
is a one-time process that involves sending a machine-specific installation code by e-mail to 
Tomcej and receiving a license file in return. 


